User’s Manual

[image: image24.png]| [ Select g3 Create X Delete &) Display |





Help File 

And 

Tutorial for TreeSAAP 3.2

Windows and Macintosh 

Tree SAAP Help
A Brief Introduction to Using the 

Selection of Amino Acid Properties Based on Phylogenetic Trees 

Program.

Index:

Overview

[image: image2.png]8066 TreeSAAP 3.2
Fle_GeneticCodes Optons_Felp

@|s]|B]s]|e
[ Parser | ®Tree  (OTaxa  [5 Properties | @ BASEML | & Evpthwy | (@ Operational | i Run

MW

3 Pair-Wise

@ Limit DNA Data to Capitals
™ Display Progress Window for Opening Files

Percentage of Ambiguous Codons may be over Valid Codons (between 0,1)
05

Depth of data outputted when reading in a file - see documentation (between 0,7)
Location : [/ Genetic Analysis & Software Development/ Genetic Analysis/Mol £
Depth: 7

Tree File Output Options
@ Print Tree Header to file
@ Print Tree's Taxa to file
@ print Ancestral Data to file
@ Print Tree's Nodes to file

Save Reset





Welcome to TreeSAAP, the Selection of Amino Acid Properties using Phylogenetic Trees model.  The methodology of this program is to take aligned coding DNA sequences (CDSs), based on the MM01 mathematical model along with implemented modifications (McClellan et al 2005), and assign statistical probability values to a wide range of known amino acid properties in these given sequences (for a full list of these properties see Property below).  Based on these statistical values, TreeSAAP accurately predicts not only the presence of positive selection on given regions of CDSs, but also identifies the specific properties of these regions, thus accurately defining a single gene’s evolutionary descent.

This program is intended for use by scientists and professionals familiar with general molecular biological principles, and allows the user ready access to formulation and output of data.

The File Menu Bar
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The file menu bar contains several menus that allow you to open and close Nexus files, and make cursory changes to your data.

File
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The File menu allows you to open a new Nexus file (*.nxs), open additional files, open TCS trees, and close files individually.

Genetic Codes
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In the Genetic Codes menu, you are able to select a preference from a list of genetic code families.  TreeSAAP defaults to Universal.


Options
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The options menu allows you to save your current data restraint settings, or reset to default.


Help
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The help menu allows you to view this document and other credits involved with this program.

The Tool Buttons

[image: image8.png]




The tool buttons are easy access links to functions in the file menu bar – they are:

Open | Open New | Save Settings | Reset Settings | Help.

The Toolbar

[image: image9.png][ parser  ®Tree (OTaxa [C Properties @ BASEML & Evpthwy (@ Operational &y Run  [8] Pair-Wise |






The toolbar is a useful interface that allows the user the ability to set, reset, and edit various data constraints.


Parser
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The Parser menu allows the user to establish the type of DNA data TreeSAAP will recognize, display a real-time progress window for monitoring output, percentage of codon ambiguity can be adjusted, as well as depth of data.  Finally, TreeSAAP has the option of deciding whether or not certain data files are saved into the output directory.


Tree
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When the Display button within the Tree menu is pressed, TreeSAAP will display the evolutionary tree embedded within the source file.  This tree will be in PAUP format, and will be non-GUI (text code) in nature.

Taxa
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The Taxa menu lists the taxa (individual sequences) from the source file and allows the user to Display the entirety of the sequence for any given individual taxa.


Properties
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The Properties menu is useful for organizing the desired amino acid properties into easy-to-use lists that can be accessed independently of the program defaults.

Select

Select allows the user to choose a specific list of available properties to test.  If none are available, TreeSAAP will default to use all.

Create

In the Create menu, the user is able to select specific properties and add them to a list.  The user must still select this list from the Select menu if they wish to use it instead of the default value. 

Delete


If any of the lists become obsolete or useless, the user may delete them at will.

Display

This function shows the user the lists of amino acid properties and gives the user the option of displaying all the properties of that list.

BASEML
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TreeSAAP uses Ziheng Yang’s Baseml program (See Yang 1996) to calculate ancestral sequences from a given tree.  TreeSAAP uses a graphical front-end to this program to simplify its use.  The interface is straightforward, and allows the user to select the specific model to use in testing for evolutionary probability of the data set.  There are 8 models in all, and TreeSAAP defaults to the REV model.  The user is also given the options of altering statistical variables, and changing the output directory for processed data.

Evpthwy
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The evolutionary pathway or Evpthwy is useful for setting up values for statistical positive selection.  Here the user can change the number of categorical tests (ranging from conservative to radical) to perform, and how many to display in the output file; here, the default is 8.  Other output options are listed by category including the 95, 99, and 99.9% statistical confidence levels.

Operational
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Here the user can change the output directory and names of individual files.  The output directory is defaulted within the TreeSAAP root folder as well as the names of output files.  The user, however, must select the name of the output tree file.

Run
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The run menu is a simple interface where the user can select whether or not to display the TCS tree, display the progress window, and use edges from the given TCS tree file.  The user may select multiple processors to be used the size of the sliding window for amino acid property observation (default to length of data), and the increment to give the sliding window (default to 1).  From here you can save these options and RUN the TreeSAAP model of Molecular Evolutionary Pathways.
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Running TreeSAAP​​​:  A Tutorial

Disclaimer:  This is a command-heavy walkthrough.  It will be useful to have a more experienced student/professor to help out while you figure out these steps.  Also, this Tutorial is subject to change, and will need updating.  If you notice anything not up to date, please request and updated version – or make suggestions – to either Rick Smith or Dr. McClellan.
· How to Import a Tree File and Run Amino Acid Property Tendency Tests

1. Open TreeSAAP and open the TreeSAAP Nexus file that has your PAUP tree appended to it.  It should be titled <Name>_TS.nex or something similar. 

2. If the file opens correctly, you should be able to display a tree file under the Tree tab, and a list of the sequences used under the Taxa tab. [image: image19.png][ Parser  ®Tree (DTaxa [E Properties @ BASEML G Evpthwy (@ Operational My Run





If, however, it does not open correctly (i.e. there are no taxa to open, or everything has $$$$ instead of taxonomic names, please get help from an experienced user.

3. Under the Properties tab, you will see a list of the Amino Acid properties that TreeSAAP utilizes.  Under the Operational tab, you will see some of the controls and constraints to be placed on data output, as well as an appropriate folder to output the TreeSAAP files into.  Change the name of the output file folder to a more usable location, and change the name of your tree to match the name of your NEXUS file. [image: image20.png]Output Directory
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Save this information by clicking the save button at the bottom of the Operational menu.  

4. In order to run TreeSAAP’s set of tests on your data set, go to the Run tab, and make sure that for this first run, your sliding window size is set to “length.”  You will change this later on, but for this first run we will leave it as the whole length.  [image: image21.png]¥ Display TCS Tree in Window Tree Options.
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Now select Run, and observe the output:  it will include a tree (we will return to this later, but close it for now) and your output folder will now have the TreeSAAP output files.  (As before, don’t forget to save your preferences).

5. Open up your output folder and go to the output => evpthwy directory.  Select the Z-SigProp.txt file and “Open with…” Microsoft Excel.

6. From the Data tab, select “Sort…” and sort first by category/descending, and secondly by value, also descending.

7. You will notice three columns of asterisks at the far right of the document denoting the probability values of .05, .01, .001, each inferring their relative percent probability 95%, 99%, and 99.9% respectively.  Each column also displays a value bounded by ().  This value refers to the statistical z-score value that corresponds with these probability values, and will be a standard for determining whether or not a particular amino acid property has undergone positive selection.  The probability/z-score values for individual properties are found in the “Value” column.  In the “Category” column, eight different values (1-8) denote the magnitude of radicality in selection.  The more radical the selection occurring, the higher the value (i.e. 1 is the most conservative, and 8 is the most radical).  Since we are looking for positive destabilizing selection, the most radical of the values are important to us (i.e. 6-8).  In the far left column marked “Property,” there are titles referring to properties of amino acid sequences in proteins (or codon sequences in genes), which may or may not demonstrate positive selection in the sequences being used.

a. Locate the properties that fall into categories 6 through 8, values of +3.09 and higher, and have and asterisk at .001 (3.09).

b. Record these specific properties and their magnitude of change (this is important) and re-open TreeSAAP.
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8. Open the Properties tab, and make a new properties list.

a. First, click Create and type in a name for this list (preferably referring to the name of the sequence set), and click Create New List.

b. Second, select all the properties you found in the spreadsheet denoting highly positive, radical changes, and then click Add to New List.

c. Check to see that the properties listed are those you wish to use and Remove those that are unneeded.  Click Create New List again.

d. Click the Select tab and select the properties list you just set up.

9. From the Operational tab, make sure that the output folder is the desired folder, and go to the Run tab.

10. In the Run menu, choose a value for your sliding window.  You may wish to do multiple tests with sliding windows ranging anywhere from 1 to the entire length of your sequences, but a good median length is about 20†.  Run TreeSAAP again, and return to your output folder.  (†For an in depth discussion about the size of the sliding window, refer to Dr. McClellan).

11. In your output folder, there will be a new folder.  Open it and go to the => evpthwy => sliding window directory.  There are now several text files, each referring to one of the amino acid properties you previously selected.  From here you will open each one with Microsoft Excel.

12. There are some differences in this spreadsheet.  The upper left hand cell should read “Windows for <Name> Z-Scores by Category” (the name referring to the property you chose earlier).  Below it are many values falling under the From and To columns.  These reflect the size of your sliding window and are individual tests run on the sequences in the sliding window previously chosen.  Listed after these columns are the categories 1 through 8.  Remember that 6, 7, & 8 are the only values we are interested in.  As you look, you will notice values in the cells of these columns – these are the z-score values.  Select all the data in one of the columns (you can drag down the whole column, but it is much easier to select the first cell of the column and press Ctrl + Shift + Down (or Apple + Shift + Down on the Macs).  We will need to format the cells to determine where on the sequences positive selection is occurring:

a. Select “format” from the toolbar, and click on Conditional Formatting…  Set the condition to read: Cell Value is/ Greater than/ 3.09.  This will select and highlight those regions where the sliding window picks up positive selection.  Remember to only select the values in the column that coincides with the magnitude you recorded for that property – the rest is just background noise.

b. Now format these conditions by clicking the “format…” button.  This will bring up a formatting menu – select Patterns, and choose a bright color from the palette.

c. Return to your document and as you scroll down you will encounter cells that are highlighted with the color you just selected – these are the sections involved in positive selection.

Graphical Analysis: (It is highly recommended to have mentored help from here on out)…
1. If you want to see graphically what’s going on, follow these steps:

a. You can create a graph of the values by doing the following:

i. Click the chart wizard button:[image: image23.bmp]
ii. Select Line, and choose the format with no points, labels, etc…

iii. Follow the wizard.

b. You will notice that the peaks above 3.09 correspond to the highlighted regions of your chart.  These are the regions selected for positively, and more than likely refer to active sites of the proteins in question and are involved in protein-specific function.

c. At this point, repeat all steps 11-14 for each individual property.  This will more than likely leave you with more information than necessary, but when compared with 3-D structures (located in the PDB database, which can be found on NIH’s NCBI database website), can help demonstrate sites of specific positive selection.

2. If you’re finished ogling your graphs, there are finer analyses to be done.  This may sound a little asinine, but you need to make a new spreadsheet with all the sliding window properties.

a. Copy the sliding window regions and paste them down one side of your sheet and then copy and paste JUST the areas from your individual properties in separate columns. (Keep areas of magnitude separate – don’t combine the columns).  Make sure you take note of what goes where.

b. When you’re finished copying and pasting all the properties, hold down shift and scroll down with the mouse wheel.  This will zoom out your sheet until it is small enough that it becomes a graph of your windows.  Please note that these are JUST the windows and NOT the actual sites of positive destabilizing selection.  You will use these again in the future.

3. In your Output folder from TreeSAAP there should also be a folder [Output] > Substs with a file NsynSubs.txt.

a. Open the NsynSub.txt file with Excel.

b. You will notice that it has the individual sites of selection marked by the codon number, the magnitude for that site, and whether the selection at that site is increasing or decreasing the property at that site.

c. Sort everything by the ascending codon #.  This will show you that some codons have multiple nodes that are experiencing selection, as well as individual sites being selected for by whole suites of AA properties.  

d. We want to use the AA property sliding windows to highlight these areas (with a LIGHT color – we will be superimposing more data on top of these ones).  Now, if there are regions of overlap between different magnitudes of change within the same property, it is OK to map it on the property, we just need to use a different color to highlight the different magnitudes (ONLY 6-8).

e. This data can be mapped onto the tree at the individual nodes, and can also be superimposed on the 3-D structure.

